
  



Installing the software 
 

     It does not matter if you download the program using a link you received after purchasing Exact Change, or if you download the 
program using the “Download now” button on the Exact Change web site; booth links provide the same installation file.  That 
installation program can be used for trial mode, if you’re evaluating the software or for the full program if you’ve already purchased a 
program license. 
 

Activating the software 
 
     When you load the Exact Change program, a window appears in 
which you can enter a license code, this is a code that you’ll received 
after purchasing a program license.  If you’re evaluating the software 
and do not yet have a license code, you can proceed by clicking the 
button labeled “Continue in trial mode” 
 
If you have a license code, you can enter one number of the code into 
each of the boxes and then click the “OK” button to activate the fully 
functional program. 

 

Selecting a collection file  

 

     Before adding coins to a collection, you first need to select the collection 
file that you want to open.  To accomplish that, Exact Change displays a 
window that provides a few options for selecting your collection file. 
 
     The first time you use Exact Change, you’ll want to select the “Create a 
new collection file” since you don’t yet have a collection started.  Thereafter, 
you’ll probably use the third option, “Open a recently used file” to return to 
the same collection file you used the last time you used Exact Change. 
  
    Consider for a moment the way a word processor program loads and saves 
data.  When you start your word processor, you’ll have a blank document.  
You can write a letter by starting with the blank document or you can open a 
letter that you’d previously written.  When you’re finished, you have the 
option of saving your letter to disk. 
  
     Exact Change works the same way, except that instead of starting you out with a blank document, it automatically adds series for all 
United States coinage.  If you add a bunch of coins to your collection and then save it to disk, the coins will be there the next time you 
start the program only if you load your collection again. 
  
     You may have any number of collection files; perhaps each member of your family may have their own collection file for example. 
Just as with a word processor, your changes are written to your drive when you choose to save your work and you can make a backup of 
your work by making a copy of that one file.   



The “Series” page 
 
     The “Series” page provides you with a 
powerful tool to organize your collection in 
whatever way best suits your needs as a 
collector.  It uses an outline structure to 
represent each type, or series, of coin that 
may be present in your collection.  Each 
series contains a particular type of coin, such 
as an Indian cent.   
 
     These series may in turn be placed into 
another series.  For example the “Indian 
cents” series and the “Wheat cents” series are 
placed together into a series titled “Cents”.   
 
     When you first start Exact Change, it 
automatically creates a series for each type of 
U.S. coin, so you don’t have to do this 
manually.  Of course, you can add, move, 
delete and rename series in order to tailor 
Exact Change to your preferences. 
 
The series you select here determines which items will be displayed on the other pages.
nickels” on the “Series” page, then the “Pricing” page will 
buffalo nickels in your collection.  Any reports you print on the 
select “Entire collection” on the series page, then every coin in your collection will be listed in a printed report.  So, the 
the starting point where you indicate what series of coins you want to work with at this moment.
 
     All of the coin series are a part your collection,
name of that series.  If there are series within that series, the program will display these right below the series you opene
suppose you want to look at your Barber Quarters
denominations will appear below “United States”.  If you then click on the series labeled “
will appear below “Quarters”.  From that list you can now select the series “
see, each time a series is selected, the available choices get more specific until we get to the particular coin type we’re 
 
In the lower right corner of the window are three tabs, which allow you to view information about the 
currently selected series... 
 
Image tab: 
Displays a thumbnail image of both the obverse (front) and reverse (back) of a typical coin from t
series.  If you’re just starting out with Exact Change, you probably don’t see these images because they first 
need to be downloaded; on the next page we’ll look at how that’s done.
 
Themes tab: 
The Themes tab is a tool for people who collect
“Zodiac coinage”.  It provides a way to search for coins which 
 
Stats tab: 
The Stats tab displays statistical information about the selected series
of coins of that series which you’ve entered, their total price and value, metallic content and so forth.
 
 
  

The series you select here determines which items will be displayed on the other pages.  For example, if you select “Buffalo 
page, then the “Pricing” page will display prices for buffalo nickels.  The “Coins” page will display all the 

buffalo nickels in your collection.  Any reports you print on the “Reports” page will list only buffalo nickels.  On the other hand, if you 
page, then every coin in your collection will be listed in a printed report.  So, the 

the starting point where you indicate what series of coins you want to work with at this moment. 

your collection, represented by the safe at the top of the window.  To open a series, just click on the 
name of that series.  If there are series within that series, the program will display these right below the series you opene

Barber Quarters collection.  When you click on the series labeled “United States”. A list of applicable 
denominations will appear below “United States”.  If you then click on the series labeled “Quarters”, a list of the various 

”.  From that list you can now select the series “Barber quarter”; the picture above depicts this.  As you can 
see, each time a series is selected, the available choices get more specific until we get to the particular coin type we’re 

In the lower right corner of the window are three tabs, which allow you to view information about the 

Displays a thumbnail image of both the obverse (front) and reverse (back) of a typical coin from the selected 
If you’re just starting out with Exact Change, you probably don’t see these images because they first 

need to be downloaded; on the next page we’ll look at how that’s done.   

The Themes tab is a tool for people who collect coins of various themes, such as “Coins with animals” or 
“Zodiac coinage”.  It provides a way to search for coins which include certain design elements. 

splays statistical information about the selected series.  This information includes the number 
of coins of that series which you’ve entered, their total price and value, metallic content and so forth. 

For example, if you select “Buffalo 
display prices for buffalo nickels.  The “Coins” page will display all the 

page will list only buffalo nickels.  On the other hand, if you 
page, then every coin in your collection will be listed in a printed report.  So, the “Series” page is 

represented by the safe at the top of the window.  To open a series, just click on the 
name of that series.  If there are series within that series, the program will display these right below the series you opened. For example, 

collection.  When you click on the series labeled “United States”. A list of applicable 
”, a list of the various quarter designs 

he picture above depicts this.  As you can 
see, each time a series is selected, the available choices get more specific until we get to the particular coin type we’re looking for. 

In the lower right corner of the window are three tabs, which allow you to view information about the 

he selected 
If you’re just starting out with Exact Change, you probably don’t see these images because they first 

coins of various themes, such as “Coins with animals” or 

n includes the number 



Downloading coin images 
 
    When a series is selected on the “Series” page, images of that coin type 
will be displayed on the right; however these images must be downloaded 
before they will appear.  In the “Tools” menu i
for updates” which provides access to Exact Change’s image download 
manager, 
 
     All coin and note issuing countries are listed, organized by continent.  
Just click the checkboxes to select the countries for which you’d like to 
download images and then click the button labeled “Begin update
 
     Depending on your internet speed, it may take a while to download 
images, but there’s no need to download images for every country right now; 
you can return to the image download manager at any time to download 
additional images.  Or you can keep using Exact Change while the download ma
 
     The “Suggest Coins” and “Suggest paper” will automatically check off all of the coin or paper money options for which there a
images which you don’t yet have.  They do this by checking 
site and comparing that number to the number of images you 
then the “Suggest” buttons will put a check by that country.
 

 

Viewing a coin’s size  
 
     Below the obverse and reverse images, in the lower
of the window, is a button labeled “View size”.  Click on this button 
to see how large the selected coin type is in comparis
common coin types; you can compare it to United States, Australian 
or Euro coinage sizes. 
 
     A red outline indicates the selected coin type’s size and shape, 
superimposed over a stack of common coins.  Along the 
this image, the coin’s size is display in numeric form.  If the 
currently selected series represents paper money, this feature will 
compare this note’s size to that of a U.S. dollar. 
  

page, images of that coin type 
however these images must be downloaded 

appear.  In the “Tools” menu is an option labeled “Check 
for updates” which provides access to Exact Change’s image download 

All coin and note issuing countries are listed, organized by continent.  
Just click the checkboxes to select the countries for which you’d like to 
download images and then click the button labeled “Begin update”.  

d, it may take a while to download 
images, but there’s no need to download images for every country right now; 
you can return to the image download manager at any time to download 
additional images.  Or you can keep using Exact Change while the download manager works on getting those images. 

The “Suggest Coins” and “Suggest paper” will automatically check off all of the coin or paper money options for which there a
images which you don’t yet have.  They do this by checking the number of images available for each country on the Exact Change web 

that number to the number of images you have; if the server has more images for a given county than your drive has, 
check by that country. 

 
Viewing the image detail 
 
     Once the images for a country are downloaded, they will 
appear on the right side of the series page whenever a coin series is 
selected.  Clicking on either of these images will display a larger 
and more detailed view of that coin type
large image).  Clicking on the larger image will produce an 
on-screen magnifying glass which can be used to view even greater 
detail. 

 

 

 

obverse and reverse images, in the lower-right corner 
is a button labeled “View size”.  Click on this button 

to see how large the selected coin type is in comparison to various 
common coin types; you can compare it to United States, Australian 

ndicates the selected coin type’s size and shape, 
superimposed over a stack of common coins.  Along the right side of 
this image, the coin’s size is display in numeric form.  If the 
currently selected series represents paper money, this feature will 

 

nager works on getting those images.  

The “Suggest Coins” and “Suggest paper” will automatically check off all of the coin or paper money options for which there are 
country on the Exact Change web 

ven county than your drive has, 

  

Once the images for a country are downloaded, they will 
the right side of the series page whenever a coin series is 

selected.  Clicking on either of these images will display a larger 
and more detailed view of that coin type (click again to remove the 
large image).  Clicking on the larger image will produce an 

ich can be used to view even greater 



The pricing page 
 
     The pricing page provides the ability to view or 
and mint mark combinations that are applicable to the type of coin in 
the currently selected series.  You can also edit the price information 
for each year and mint mark combination.  
 
     Each column in the price grid represents a single year, mint mark, 
and variety combination.  So a coin minted at two mints over a five 
year period would have ten columns in the pricing grid, two columns 
for each year. 
 
     The row labeled “Variety” provides the ability to create multiple 
columns of pricing information for the same year and mint mark 
combination where varieties exist.  Over-dates are a common examp
of a minting variety. 

 
     Exact Change also includes an entry in each column for the “GM” or Grade Modifier.  The grade modifier allows you to specify 
information which augments a coin’s grade.  For example, copper cents are often labeled RD (red), RB
to indicate the coin’s color.  Standing liberty quarters of exceptional strike quality are labeled FH (full head) if the deta
head are well defined by a sharp strike.  In many ways, the grade modifier is simil
modifier designates different qualities of otherwise identical coins.  Many certified coins are designated with a grade modif
example, a certified cent’s holder may indicate MS
 
 Exact Change will group coins with different grade modifiers together when logical.  For example, when calculating the 
number of varieties of wheat cents which exist, Exact Change reports a total of 148.  There are actually 444 columns in the p
wheat cents.  There are three columns for each Year, Mint, and Variety combination, each with a different grade modifier (RD, 
BN).  Since the only difference between the three columns is the grade modifier, Exact Change counts them as just one variet
you’re collecting wheat cents and you have a nice red cent, you wouldn’t want your checklist to indicate that you still need 
same variety but which has toned brown. 
 

Modifying the price list 
 

 
     Exact Change is pre-configured with columns in the price grid for most collectable American coinage.  So you would typically 
have no need to add columns to the pricing grid.  This feature is included in Exact Change to allow you to enter pricing info
additional coin types you may create such as tokens.  To add a new column, press the button labeled “Add”.  The “Delete” butt
delete the currently selected column.  
 
     Note: When you add a column or change the Year, mint, variety, or g
automatically resort the columns whenever you leave the prices page.  New columns are always added on the right side of the t
they’ll automatically be sorted into the correct order.
 
     When you add a coin to your collection, you’ll select the coin from this list.  So if you’re adding a new coin series (such as f
coins) you may want to include all year and mint combinations, even if you don’t intend to enter pricing information (the pr
left blank if you choose).  The “Pricing” page is much like a typical spreadsheet; you can click on any cell within the table and edit the 
value of that cell. 

     When entering a price, simply type in the value for the selected 
For example, price lists never list a G-4 value for a modern proof coin which was issued in protective packaging.  In this case, you can 
simply click on the small button beside the price and 
this way rather than typing in a monetary value. 

 
     Exact Change can calculate a value for a particular grade if pricing information for that grade is not available.  Fo
enter an MS-61 value, and an MS-63 value, you can instruct Exact Change to calculate the MS
between the two.  Just as you can select a value of “Proof only”, you can select values from “Split 0%”
example, if you select an MS-62 value of “Split 50%”, then Exact Change would calculate the MS
the MS-61 value and the MS-63 value.  You can split the values of several grades in a row and 
unknown values. 

view or edit the list of year 
and mint mark combinations that are applicable to the type of coin in 

ies.  You can also edit the price information 

Each column in the price grid represents a single year, mint mark, 
and variety combination.  So a coin minted at two mints over a five 

columns in the pricing grid, two columns 

The row labeled “Variety” provides the ability to create multiple 
columns of pricing information for the same year and mint mark 

dates are a common example 

Exact Change also includes an entry in each column for the “GM” or Grade Modifier.  The grade modifier allows you to specify 
information which augments a coin’s grade.  For example, copper cents are often labeled RD (red), RB (red & brown), and BN (Brown) 
to indicate the coin’s color.  Standing liberty quarters of exceptional strike quality are labeled FH (full head) if the deta
head are well defined by a sharp strike.  In many ways, the grade modifier is similar to the variety.  It differs though, in that the grade 
modifier designates different qualities of otherwise identical coins.  Many certified coins are designated with a grade modif
example, a certified cent’s holder may indicate MS-66RD.   

ct Change will group coins with different grade modifiers together when logical.  For example, when calculating the 
number of varieties of wheat cents which exist, Exact Change reports a total of 148.  There are actually 444 columns in the p

heat cents.  There are three columns for each Year, Mint, and Variety combination, each with a different grade modifier (RD, 
BN).  Since the only difference between the three columns is the grade modifier, Exact Change counts them as just one variet
you’re collecting wheat cents and you have a nice red cent, you wouldn’t want your checklist to indicate that you still need 

configured with columns in the price grid for most collectable American coinage.  So you would typically 
have no need to add columns to the pricing grid.  This feature is included in Exact Change to allow you to enter pricing info
additional coin types you may create such as tokens.  To add a new column, press the button labeled “Add”.  The “Delete” butt

Note: When you add a column or change the Year, mint, variety, or grade modifier information in a column, Exact Change will 
automatically resort the columns whenever you leave the prices page.  New columns are always added on the right side of the t
they’ll automatically be sorted into the correct order. 

n you add a coin to your collection, you’ll select the coin from this list.  So if you’re adding a new coin series (such as f
coins) you may want to include all year and mint combinations, even if you don’t intend to enter pricing information (the pr

The “Pricing” page is much like a typical spreadsheet; you can click on any cell within the table and edit the 

value for the selected grade.  Some grades may not apply to a particular type of coin.  
4 value for a modern proof coin which was issued in protective packaging.  In this case, you can 

simply click on the small button beside the price and select “Proof only”.  There are a variety of adjectives that you can select from in 
 

Exact Change can calculate a value for a particular grade if pricing information for that grade is not available.  Fo
63 value, you can instruct Exact Change to calculate the MS-62 value as a percentage of the difference 

between the two.  Just as you can select a value of “Proof only”, you can select values from “Split 0%” to “Split 100%”.  In the above 
62 value of “Split 50%”, then Exact Change would calculate the MS-62 value as being half way between 
63 value.  You can split the values of several grades in a row and Exact Change will calculate all the 

Exact Change also includes an entry in each column for the “GM” or Grade Modifier.  The grade modifier allows you to specify 
(red & brown), and BN (Brown) 

to indicate the coin’s color.  Standing liberty quarters of exceptional strike quality are labeled FH (full head) if the details of Liberty’s 
ar to the variety.  It differs though, in that the grade 

modifier designates different qualities of otherwise identical coins.  Many certified coins are designated with a grade modifier.  For 

ct Change will group coins with different grade modifiers together when logical.  For example, when calculating the 
number of varieties of wheat cents which exist, Exact Change reports a total of 148.  There are actually 444 columns in the price list for 

heat cents.  There are three columns for each Year, Mint, and Variety combination, each with a different grade modifier (RD, RB, or 
BN).  Since the only difference between the three columns is the grade modifier, Exact Change counts them as just one variety.  If 
you’re collecting wheat cents and you have a nice red cent, you wouldn’t want your checklist to indicate that you still need a coin of that 

configured with columns in the price grid for most collectable American coinage.  So you would typically 
have no need to add columns to the pricing grid.  This feature is included in Exact Change to allow you to enter pricing information for 
additional coin types you may create such as tokens.  To add a new column, press the button labeled “Add”.  The “Delete” button will 

rade modifier information in a column, Exact Change will 
automatically resort the columns whenever you leave the prices page.  New columns are always added on the right side of the table but 

n you add a coin to your collection, you’ll select the coin from this list.  So if you’re adding a new coin series (such as foreign 
coins) you may want to include all year and mint combinations, even if you don’t intend to enter pricing information (the prices can be 

The “Pricing” page is much like a typical spreadsheet; you can click on any cell within the table and edit the 

grade.  Some grades may not apply to a particular type of coin.  
4 value for a modern proof coin which was issued in protective packaging.  In this case, you can 

There are a variety of adjectives that you can select from in 

Exact Change can calculate a value for a particular grade if pricing information for that grade is not available.  For example, if you 
62 value as a percentage of the difference 

to “Split 100%”.  In the above 
62 value as being half way between 
Exact Change will calculate all the 



 The coins page 
 
The coins page is where you actually enter information about the 

coins in your collection. 
 
If you’ve already entered any coins into the selected coin series 
then the table on the top half of this page will list those coins and 
one of these coins will be selected (Highlighted with a blue bar).  
The information about the selected coin will be displayed in the 
boxes on the bottom of the page. 
 
The bottom half of this page displays specific information about 
the highlighted coin.  This is where you enter information about a 
new coin or modify the information about a coin you’ve already 
entered. 
 
Adding and removing coin entries. 
 
There are three buttons in the lower right corner of the coins page labeled “New”, “Clone” and “Delete”.  These buttons are used to add 
and remove coins in your collection. 
 
New: The new button will create a new coin entry in your collection.  Once you add the coin, enter the information such as year, grade 
and so forth in the spaces provided. 
 
Clone: The clone button is used to rapidly enter a number of similar coins.  When you click this button, a new coin will be added to your 
collection by making an exact copy of the selected coin.  You can then adjust any settings that differentiate the new coin from the one 
you copied. 
 
Delete: The delete button removes the currently selected coin from your Exact Change collection.  If you sell a coin, you can delete it 
from your collection, or change the coin to a sold status so that you retain a record of what happened to the coin.  There are 14 edit boxes 
which allow you to enter specific information about each coin in your collection.  When you click on a coin from the list atop the coins 
page, a coin you’ve already entered, these boxes will display the information about that coin and you can make any changes you wish. 
 
Year, Mint & variety: This field allows you to select the coin you’re entering.  The list of available choices is taken from the price list 
for this coin series. The checkbox beside each entry in the list indicates which coins are already included in your collection.  
 
Grade: Click on the button attached to this box to indicate the grade of the coin you’re entering.  This will be used by Exact Change to 
determine the coin’s value.   
 
GM: The Grade Modifier allows you to indicate a designation, which augments the coin’s grade and may therefore affect the coin’s 
value.  For example, copper coins have three choices for grade modifiers, RD (red), RB (red & brown), and BN (Brown).  Some coin 
series have several grade modifier options; others have no applicable grade modifiers. 
 
Graded by: This box allows you to indicate who graded the coin.  You can select from the predefined list of grading services or enter a 
freeform name such as “Bob”. 
 
Date purchased: This box is used to enter the date that the coin was purchased.  Click on the button attached to this box to select a date 
from a pop-up calendar. 
 
Buy price: This box is used to indicate the price you paid for the coin.  This is not a required field, but Exact Change cannot calculate 
your profit or loss on this coin without this information. 
 
Date Sold: This box can be used to indicate when you sold the coin, if applicable. 
 
Sell Price: This box is used to indicate the price for which you wish to sell the coin.  If you don’t wish to sell the coin then you can 
simply leave this box empty.  This information is displayed on the “Sell list” report. 
 
Stored in: This box is used to indicate where the coin is physically stored.  You can select from one of the predefined storage methods 
or enter your own note, such as “Under mattress”.  When you add a coin to your collection with a user defined storage location, that 
storage location will be added to the list of predefined storage methods.   
 
Have: This indicates the number of coins you’re entering.  You can create an entry for each coin in your collection.  However, if 



you’re entering a roll of wheat cents, you’ll probably want to make a single entry and set “Have” to 50.  If you’re entering 
coins, you could make five entries, each with a “Have” value of one, or one entry wi
yours.  Keep in mind that if you enter multiple coins in the same entry, they must be identical.  For example, if you purchas
identical coins today, and 10 more tomorrow, then you’ll probably want to ma
because the first lot has a different date of purchase that the second lot.  A general rule is that if you’re entering large 
value coins, you may want to group them as a single lot
they’re identical. 
 
Need: This indicates the number of additional coins of this type that you want.  For example, if you are filling 10 albums and you 
acquire 3 coins of a given type, then you could enter 3 in the “Have” field and 7 in the “Need” field.  This information is used to 
determine which coins should appear in your “Buy list” report.
 
Sell: This box indicates the number of coins of this type you wish to sell.  This
appear in your “Sell list” report. 
 
Sold: This box indicates the number of coins of this type you’ve sold.  When you sell a coin from your collection, you could simply
delete the coin’s record.  Or, you could change the “Have” field to zero and the sold field to one.  This way, Exact Change will retain 
the information about the coin but won’t show it as a coin in your inventory.
 
Comment: This box is used to provide a short comment about the coin; more ex
This provides a short descriptor that can be included in a single report column.
 
Mint error: A check in this box indicates that the coin is a mint error and should therefore be included in the Mint Er
errors are not included in the Series Checklist or Type Collection Checklist reports.  Though this may seem odd, the reason i
you’re collecting a series by date and mint mark, and you obtain a specimen that’s stuck 50% off ce
obtain a normal specimen of that variety to complete your set.
 
Track: This checkbox allows you to designate specific coins within your collection that meet whatever criteria you wish.  For exampl
you might use it to designate coins that you need to take to the next coin show.  Later, you might use it to designate coins which you’ve 
sent to a grading service for certification.  See the section labeled “Utilizing coin tracking” for more information.
 
Notes: This field allows you to enter any additional information or history about the coin.  This memo is freeform and can be of any 
length.  To the left of the “Notes” label is a small button which will enlarge the notes box, allowing you to view a great de
note at one time.  Click this button again to return the notes box to its normal size
 
 
 

Populating a coin series  
 
     The “Populate” button on the bottom of the “Prices” page creates a coin 
entry for every year, mint and Variety combination listed on the price list.  Each 
of these entries has a zero quantity, so populating a series adds database entries 
but doesn’t actually add any coins.  Because all of the coin entries are already 
created, you can then add a coin to your collection simp
entry on the “Coins” page and increasing the “Have” quantity by one.  This is 
generally most useful when entering a bulk of similar coins, such as a bag of 
wheat cents.

 
 
 

you’re entering a roll of wheat cents, you’ll probably want to make a single entry and set “Have” to 50.  If you’re entering 
coins, you could make five entries, each with a “Have” value of one, or one entry with a “Have” value of 5.  The decision is entirely 
yours.  Keep in mind that if you enter multiple coins in the same entry, they must be identical.  For example, if you purchas
identical coins today, and 10 more tomorrow, then you’ll probably want to make two entries, each with a “Have” value of ten.  This is 
because the first lot has a different date of purchase that the second lot.  A general rule is that if you’re entering large 
value coins, you may want to group them as a single lot, but most people prefer to enter valuable coins each in their own entry, even if 

This indicates the number of additional coins of this type that you want.  For example, if you are filling 10 albums and you 
given type, then you could enter 3 in the “Have” field and 7 in the “Need” field.  This information is used to 

determine which coins should appear in your “Buy list” report. 

This box indicates the number of coins of this type you wish to sell.  This information is used to determine which coins should 

This box indicates the number of coins of this type you’ve sold.  When you sell a coin from your collection, you could simply
could change the “Have” field to zero and the sold field to one.  This way, Exact Change will retain 

the information about the coin but won’t show it as a coin in your inventory. 

This box is used to provide a short comment about the coin; more extensive comments should be placed in the notes field.  
This provides a short descriptor that can be included in a single report column. 

A check in this box indicates that the coin is a mint error and should therefore be included in the Mint Er
errors are not included in the Series Checklist or Type Collection Checklist reports.  Though this may seem odd, the reason i
you’re collecting a series by date and mint mark, and you obtain a specimen that’s stuck 50% off center, you’ll probably still want to 
obtain a normal specimen of that variety to complete your set. 

This checkbox allows you to designate specific coins within your collection that meet whatever criteria you wish.  For exampl
esignate coins that you need to take to the next coin show.  Later, you might use it to designate coins which you’ve 

sent to a grading service for certification.  See the section labeled “Utilizing coin tracking” for more information.

lows you to enter any additional information or history about the coin.  This memo is freeform and can be of any 
length.  To the left of the “Notes” label is a small button which will enlarge the notes box, allowing you to view a great de

e at one time.  Click this button again to return the notes box to its normal size. 

The “Populate” button on the bottom of the “Prices” page creates a coin 
ion listed on the price list.  Each 

of these entries has a zero quantity, so populating a series adds database entries 
but doesn’t actually add any coins.  Because all of the coin entries are already 
created, you can then add a coin to your collection simply by selecting the correct 
entry on the “Coins” page and increasing the “Have” quantity by one.  This is 
generally most useful when entering a bulk of similar coins, such as a bag of 

you’re entering a roll of wheat cents, you’ll probably want to make a single entry and set “Have” to 50.  If you’re entering 5 identical 
th a “Have” value of 5.  The decision is entirely 

yours.  Keep in mind that if you enter multiple coins in the same entry, they must be identical.  For example, if you purchase 10 
ke two entries, each with a “Have” value of ten.  This is 

because the first lot has a different date of purchase that the second lot.  A general rule is that if you’re entering large quantities of low 
, but most people prefer to enter valuable coins each in their own entry, even if 

This indicates the number of additional coins of this type that you want.  For example, if you are filling 10 albums and you 
given type, then you could enter 3 in the “Have” field and 7 in the “Need” field.  This information is used to 

information is used to determine which coins should 

This box indicates the number of coins of this type you’ve sold.  When you sell a coin from your collection, you could simply 
could change the “Have” field to zero and the sold field to one.  This way, Exact Change will retain 

tensive comments should be placed in the notes field.  

A check in this box indicates that the coin is a mint error and should therefore be included in the Mint Errors report.  Mint 
errors are not included in the Series Checklist or Type Collection Checklist reports.  Though this may seem odd, the reason is simple; if 

nter, you’ll probably still want to 

This checkbox allows you to designate specific coins within your collection that meet whatever criteria you wish.  For example, 
esignate coins that you need to take to the next coin show.  Later, you might use it to designate coins which you’ve 

sent to a grading service for certification.  See the section labeled “Utilizing coin tracking” for more information. 

lows you to enter any additional information or history about the coin.  This memo is freeform and can be of any 
length.  To the left of the “Notes” label is a small button which will enlarge the notes box, allowing you to view a great deal more of the 



 The images page  
 
     The “Images” page allows you to attach a picture of 
your coin to its entry in Exact Change.  This is a great 
way for you to enjoy your coins even if they’re stored 
away in a safety deposit box.  You can also attach a 
scanned image of your receipt. 
 
     The images on this page are associated with the coin 
that is currently selected on the “Coins” page.  
Therefore, if there are no coins entered on the “Coins” 
page, this tab doesn’t appear in the tabs at the bottom 
of the screen. 
 
     Both the “Series” page and the “Images”
display coin images.  The difference is that the images 
on the “Series” page are stock images that typically come 
from the Exact Change web site while the “Images” page 
is used to show pictures that you’ve taken of your own 
coins.  
 
     Each coin can have any number of images attached to it.  To select a picture, click on one of the tabs labeled “Obverse”, “Reverse”,
or “Receipt”; or click the tab labeled “Additional” to add any number of extra images.  These may include pictures of the pac
whatever you wish. 
 
     The image tab provides a number of adjustments that can be made to the displayed image.  Feel free to slide the controls arou
see how they affect the image; they don’t actually change the image file, just the on
any changes you make are just temporary and will be discarded when you switch to another image or leave the images page.
 
     The zoom control allows you to zoom in or out, so that you can see details on the coins
select a zoom value and click on the “Zoom” button.
that falls outside the viewing area.   
 
     An image is associated when it is loaded or saved.  This means that if you’re loading an image from an existing file, the association 
is made as soon as you load the image.  When you paste an image, the association is made only when you save the image to a fi
 
     You may wish to attach the same image to multiple coins.  For example, a receipt may list several purchases on a single page.  
Once the image is saved to your hard drive, you can attach it to additional coins by selecting the coin and then clicking 
“Load image” on the images page.  This doesn’t create a second copy of the file, but merely associates the image with each coin.
 
 

The “Graphs” page 

     The “Graphs” page presents data about the
currently selected series with three dimensional graphs.  The 
“Graphs” tab will appear at the bottom of the screen only if the 
currently selected series has one or more coins in it.

     The drop-down box in the upper-right corner of the window 
can be used to select the data to be graphed,  Nine slider controls 
can be used to rotate the graph in three dimensions and 
similar adjustments.  The graph can then be printed or saved as a 
bitmap file.  
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The zoom control allows you to zoom in or out, so that you can see details on the coins surface.  To modify the level of zoom, 
select a zoom value and click on the “Zoom” button.  The “Crop image” check box, when checked, will clip off any part of the image 

or saved.  This means that if you’re loading an image from an existing file, the association 
is made as soon as you load the image.  When you paste an image, the association is made only when you save the image to a fi
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The “Reports” page 
 
     The “Reports” page allows you to view and print 
reports about the items in your collection, items you 
wish to sell, items you wish to acquire, or items you have 
sold.  Exact change comes with a wide variety of 
reports.  
 
     The reports page displays any reports based
series that is currently selected on the series page
For example, if you select “Cents” on the series page, 
then all reports will include any type of cents, such as 
Indian head cents and wheat cents”.  However, if you 
select wheat cents on the series page, then all reports will 
include wheat cents only.  If you wish to create a report 
that contains all coins in your collection, then select 
“Entire collection” on the series page. 
 
     The report will not appear in the preview area if 
there are no coins included in the current report.
For example, if you select the “Sell list”, the report preview will be blank if there are no items with a “Sell” value greate
 
     You can zoom the report preview in or out to get a better view of the rep
you’re viewing by using the controls along the bottom of the window.
 
 

The reports editor 
 
     Exact Change includes a report editor which can be 
used to modify any of the existing reports or to 
reports of your own design.  Creating reports is a rather 
advanced process which requires a good understanding of 
Exact Change, so it is beyond the scope of this manual but 
there is another manual which specifically covers the report 
editor; it’s available on the Exact Change web site.  For 
now, it’s enough to know that that functionality is available.
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The report bin 
 
     There are times when it’s preferable to select exactly which coins will be included 
in a report, on a coin-by-coin basis.  The most common example of this is when 
printing on 2x2 flip inserts.  In this case, there may be 
want to print inserts for specific coins rather than printing
series.  The report bin provides the capability to select specific coins to be included in a 
report. 
 

     In the lower-left corner of the coins page is a picture which 
represents the report bin.  Below this picture is a number which 
indicates how many coins are currently in the report bin.  To add 
current coin to the bin, just click this image; click 
the coin from the bin. Notice that 
number of coins in the report bin will 
coin in the bin does not remove its listing in the selected series and you don’t need to worry ab

later.  Exact Change simply denotes the coin as one that is included in the report bin. You can add any mix of coins from any
the coin bin at the same time. 

 
     Once you’ve placed one or more coins in the report bin
can view the contents of the bin by clicking on the “Reports” tab at 
the bottom of the screen.  You’ll notice that whenever there are 
coins in the report bin, a new tab appears on the right side of the 
reports page.  Click on this tab to view a list of coins currently in 
the report bin.  If you inadvertently add the wrong coin to the 
report bin, you can select it on this list by clicking on it.  You can 
then remove the coin from the bin by clicking on the “Remove 
from bin” button.  You can remove all the coins in the bin by 
clicking on the button labeled “Empty the bin”. 

 
     Not every report utilizes the report bin.  For example, the 
“Sales sign” report pertains only to the coin currently selected on 
the “Coins” page.  However, most reports will prin
coins in the report bin or all the coins in the currently selected 
series.  The report bin provides you with the option to select 
whether the report bin will be used when printing a report.

 
     The first option will cause Exact Change to 
option selected, then Exact Change will list each coin in the report bin in the report, regardless of the series selected on 
The second option will cause Exact Change to disregard the report bin when printing 
currently selected series.  Exact Change never uses the report bin if it doesn’t contain any coins.  By default, it will use 
it does contain coins.  This option allows you to put coins in the bin and yet print reports as normal. 
 
Helpful tip:  In the “File” menu, under “Options” is a menu option labeled “Automatic report bin”.  When this menu option is 
checked, every new coin you add to your collection will automatically be added to the report bin.  That way, when you add a bunch of 
coins to your collection you can easily print inserts for just the new coins.
 
 
 
 

There are times when it’s preferable to select exactly which coins will be included 
coin basis.  The most common example of this is when 
.  In this case, there may be 20 inserts per page.  You may 
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whether the report bin will be used when printing a report. 
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option selected, then Exact Change will list each coin in the report bin in the report, regardless of the series selected on 
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currently selected series.  Exact Change never uses the report bin if it doesn’t contain any coins.  By default, it will use 

does contain coins.  This option allows you to put coins in the bin and yet print reports as normal.  

Helpful tip:  In the “File” menu, under “Options” is a menu option labeled “Automatic report bin”.  When this menu option is 
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The “eBooks” page 
 
     The “eBook” page displays information from 
publications that is relevant to the currently selected series.
 
     For example, if you’ve purchased a copy of the 
Standard Catalog of World Coins DVD from Krause 
Publications, the eBook tab can display the appropriate 
page from the catalog whenever you select a series.  No 
searching or scrolling is required; just select a series and 
click on the eBooks tab to see the page from the catalog that 
relates to that coin type. 
 
     An eBook is simply a combination of two files, a 
document file (the PDF file) and a file which contains an 
index to that document so that Exact Change can determine 
what pages in that document are relevant to each series (the 
eBook file). 
 
     If you have more than one eBook that relates to a particular coin type, the drop
to select from a list of relevant books and page numbers. 
which references the currently selected series.
 
     To set up a eBook for use with Exact Change, copy b
  
On a Windows PC, the files go in the directory \
On a Mac, the files go in the directory /Library/Application Support/Exact Change/eBooks
 
     It’s possible to override this default location and therefore store the 
technical support if you’d like assistance in chaning the 
 
     When you right-click on any series on the series editor, a menu option titled “Edit eBook” of
installed eBook.  You can create your own eBook file by placing any PDF file in the Exact Change directory and then using the
eBook” feature to associate pages within that document to 
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Selecting Favorite Series 
 
     Exact Change allows you to designate certain folders as favorite 
series.  These folders are then listed in the “Favorites” menu at the 
top of the screen, allowing you to select that series quickly, without 
returning to the series page. 
 
     In the lower right corner of the series page is a checkbox labeled 
“Favorite series” which indicates whether the currently selected coin type has been designated as a favorite series.  Simply 
box to add or remove the checkmark.  When the box is checke
screen. 
 
     The Favorites menu also includes a list of recently used series.  That is, a list of the last ten coin types for which you cl
“Coins” tab to view or edit coins of that type.  Clicking on any item in the “Recently Used Series” will select that coin type as the 
currently selected series. 
   

Using Collection Themes 
 
     Some collectors prefer to collect coins with certain themes, such as coins with birds, oddl
coins, or bi-metallic coins.  Exact Change provides a feature for these collectors to track what coins they 
have in their theme collection and what other coins they may wish to add.
 
     The Themes tab on the Series page displays a list of collec
seventeen predefined collection themes and you can modify these themes or create you
The checkbox beside each theme name indicates whether the currently select
checking or unchecking a box will add or remove the currently selected coin series to or from that 
collection theme. The blue arrow to the right of each theme is used to skip though series that are associated 
with that theme.  For example, if you click on the blue ar
Change will find the next coin type that has a turtle on it and will make that coin type the currently selected 
series.  You can roll through all of the coin types within a collection theme by just repeatedly 
blue arrow. 
 
     You can create your own themes or modify the predefined themes. 
“Program settings” is a menu option labeled “Theme setup”.  This feature provides a 
you can change the name of any theme or delete the name to remove a theme from the list.
 

Special Series Images  
 
     The U.S. Mint has recently produced some long running series 
as the 50 State Quarters™ program.  In that case, the Exact Change 
database lists each of the designs as varieties within a single coin series, 
rather than putting each design in a spate series/  It simply makes more 
sense to group these coins together rather than needing to flip between the 
Series page and the Coins page for each type of State Qua
 
 The “Special Series Images” option in the “Display” menu can 
be used to dictate which of those designs will be used to represent the 50 
State Quarters series; just select an image from the list on the left side of 
this window.  You can pick another image any time you wish; it’s just 
aesthetic choice. 
 
There are four series for which you can assign a special series image:
 
  50 State Quarters™  
  America the Beautiful Quarters™  
  Presidential dollars 
  American Innovation dollars  

Exact Change allows you to designate certain folders as favorite 
series.  These folders are then listed in the “Favorites” menu at the 
top of the screen, allowing you to select that series quickly, without 

corner of the series page is a checkbox labeled 
“Favorite series” which indicates whether the currently selected coin type has been designated as a favorite series.  Simply 
box to add or remove the checkmark.  When the box is checked, you’ll see the series listed in the “Favorites” menu at the top of the 
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ins of that type.  Clicking on any item in the “Recently Used Series” will select that coin type as the 
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For example, if you click on the blue arrow to the right of the “Turtles” theme, Exact 

Change will find the next coin type that has a turtle on it and will make that coin type the currently selected 
series.  You can roll through all of the coin types within a collection theme by just repeatedly pressing the 

You can create your own themes or modify the predefined themes. In the “File” menu, under 
“Program settings” is a menu option labeled “Theme setup”.  This feature provides a list of theme so that 
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Adding countries to your collection 

     Exact Change includes built in databases for coins and currency 
from hundreds of foreign countries.  Of course, you could create all 
the series for coins of any country you wish.  However, Exact 
Change spares you this hassle by providing these predefi
databases, complete with images, date/mint combinations, mintage 
figures and precious metal content information. This is an important 
point and one that sometimes causes confusion.   You can add 
countries to your collection with a few mouse clic
Exact Change includes only U.S. coinage.  Another family member 
may have their own collection and choose to add a different selection 
of countries. 

     To add a country to your collection, simply click “Add 
countries” in the “File” menu.  You can scroll through the list of 
predefined countries and click on a country to add it to your 
collection.  In addition to coins, there are lists of paper money and 
exonumia databases and which you can choose from.

 
     You can remove a country from your collection in the same way you would delete any other 
selecting “Delete this series” from the pop-up menu
series from your collection after you add a country.  For example, if you collect British pennies, you could add Great Britain to your 
collection and then delete the folders for shillings, farthings, and so forth.  If you later decide to expand your collection
coins, simply add Great Britain to your collection again.  Exact Change will automatically recognize that your collection already
includes British pennies, and it will add in just the missing series.
 
     You can freely add and remove countries as you wish; Exact Change will automatically handle all the details like determining 
which price lists should be loaded.   
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Customizing the series page 
 
     As we saw on the previous page, the “Add countries” menu option will add all the series for any countries you select, but you can 
also create your own custom series, make custom changes to any series, and rearrange any series however you wish. 
 
Moving a series to a new position:  To move a series to a different position, just hold down the Alt, Shift, or Ctrl keys (any one of 
them) as you click on the series to be moved and drag it to the folder that it should be placed in.  When you move a series, 
contents (coins and series) are moved right along with it.  
 

 
The series pop-up menu
provides several options for customizing that series.
 
The “Properties” menu option brings up a dialog window 
which you can change the name of the series
also includes settings for the 
coin type.  The font color and style can be used to emphasize 
this series on the series editor or color
you’d like, The “Grading Scale” setting can be used to select a 
user-defined grading scale rather than the standard 1 to 70 
point Sheldon scale.  
 

The “Obverse” and “Reverse” buttons can be used to select the images that will appear on 
the Series page when this series is selected, 
 
The checkbox labeled “This series represents a distinct country”, as the text suggests, is used 
to designate if this series represents a country (as opposed to a denomination or a coin type).  
Some reports list coins by country of origin, and this setting affects those reports.
 
The checkbox labeled “Allow program updates to change these settings”, if unchecked, will prevent program updates from changi
of the settings in this window. 
 
The “Add a new series” menu option presents a window much like the “Properties” menu option, but it creates a new series rather than 
changing the settings of an existing series.  On the 
series will appear.  The new series can be “Inside
the current series as Lincoln Cents is below Indian Cents.
 
Delete this series:  This option will remove the folder from the series page, 
selected folder are removed from the collection as well. 
 
Empty this series:  This option will, after confirming your intention, remove all the coins from the selected folder, without removing 
the folder itself.  If there are any folders within the selected folder, they are emptied as well.
 
Copy to Clipboard:  This option will copy the folder and all 
 
Paste from clipboard:  This option is only available after you’ve copied a folder to the clipboard.  It pastes the contents of the 
clipboard into the current collection file.  Any folder in the clipboard will be placed into the folder you selected, unless 
coin type already exists.  In that case, the coins in the duplicate folder are simply added to the existing folder.
 

   

  

e, the “Add countries” menu option will add all the series for any countries you select, but you can 
also create your own custom series, make custom changes to any series, and rearrange any series however you wish. 

To move a series to a different position, just hold down the Alt, Shift, or Ctrl keys (any one of 
them) as you click on the series to be moved and drag it to the folder that it should be placed in.  When you move a series, 

ries) are moved right along with it.   

up menu:   Right-clicking on any series on the series page brings up a pop
provides several options for customizing that series. 

The “Properties” menu option brings up a dialog window in 
which you can change the name of the series.  The window 
also includes settings for the size, shape, and face value of this 
coin type.  The font color and style can be used to emphasize 
this series on the series editor or color-code the series however 
ou’d like, The “Grading Scale” setting can be used to select a 

defined grading scale rather than the standard 1 to 70 
point Sheldon scale.   

The “Obverse” and “Reverse” buttons can be used to select the images that will appear on 

This series represents a distinct country”, as the text suggests, is used 
to designate if this series represents a country (as opposed to a denomination or a coin type).  

of origin, and this setting affects those reports. 

The checkbox labeled “Allow program updates to change these settings”, if unchecked, will prevent program updates from changi

ents a window much like the “Properties” menu option, but it creates a new series rather than 
On the left side of this window are two large buttons that allow you to specify where the new 

he new series can be “Inside“ the currently selected series, as Lincoln cents is inside Cents.  Or, it can be “Below” 
below Indian Cents. 

This option will remove the folder from the series page, after confirming your intention.  All coins within the 
selected folder are removed from the collection as well.  

This option will, after confirming your intention, remove all the coins from the selected folder, without removing 
der itself.  If there are any folders within the selected folder, they are emptied as well. 

This option will copy the folder and all its contents to a buffer, so that it can be pasted into a new collection file.  

This option is only available after you’ve copied a folder to the clipboard.  It pastes the contents of the 
clipboard into the current collection file.  Any folder in the clipboard will be placed into the folder you selected, unless 
coin type already exists.  In that case, the coins in the duplicate folder are simply added to the existing folder.

e, the “Add countries” menu option will add all the series for any countries you select, but you can 
also create your own custom series, make custom changes to any series, and rearrange any series however you wish.  

To move a series to a different position, just hold down the Alt, Shift, or Ctrl keys (any one of 
them) as you click on the series to be moved and drag it to the folder that it should be placed in.  When you move a series, its entire 

n any series on the series page brings up a pop-up menu that 

The checkbox labeled “Allow program updates to change these settings”, if unchecked, will prevent program updates from changing any 

ents a window much like the “Properties” menu option, but it creates a new series rather than 
e of this window are two large buttons that allow you to specify where the new 

Cents.  Or, it can be “Below” 

after confirming your intention.  All coins within the 

This option will, after confirming your intention, remove all the coins from the selected folder, without removing 

contents to a buffer, so that it can be pasted into a new collection file.   

This option is only available after you’ve copied a folder to the clipboard.  It pastes the contents of the 
clipboard into the current collection file.  Any folder in the clipboard will be placed into the folder you selected, unless a folder for that 
coin type already exists.  In that case, the coins in the duplicate folder are simply added to the existing folder. 



User defined grade Scales 
 
     As we saw on the previous page, the “Properties” window lets you assign a different 
Graded Scales window lets you design a custom scale for this purpose.  To define custom grade scales, click on “Program setti
the program’s “File” menu, then click on “User Defined Grade Scales”
 
     A custom grade scale is simply a list of the names you’d like to use for 
various grades.  For example, the Sheldon scale uses grades like Poor
way up through MS-70 and then Proof-60 through Proof
entering most coins but, particularly when entering uncertified world coinage, a 
lot of people like to use more generalized grades.  In that case, a simple scale 
like this may make more sense: 
 

 Nasty    
 Worn 
 Unc. 
 BU 
 Gem BU 
 

 
     A collection can have up to three custom scales for coin series and up to 
three custom series for paper money, plus the standard Sheldon 
point scale).  There are four columns on this window which represent 
Sheldon Scale and the three user defined scales. 
 
     Each grade in a custom grade scale is associated with a grade on the Sheldon 
Scale.  The image above depicts the simplified scale of jus
BU” correlate to the Sheldon grades VF35, AU-50, MS
 

on the previous page, the “Properties” window lets you assign a different grade scale to 
Graded Scales window lets you design a custom scale for this purpose.  To define custom grade scales, click on “Program setti
the program’s “File” menu, then click on “User Defined Grade Scales” 

stom grade scale is simply a list of the names you’d like to use for 
various grades.  For example, the Sheldon scale uses grades like Poor-1 all the 

60 through Proof-70.  That’s great for 
larly when entering uncertified world coinage, a 

lot of people like to use more generalized grades.  In that case, a simple scale 

A collection can have up to three custom scales for coin series and up to 
three custom series for paper money, plus the standard Sheldon Scale (the 1 to 70 

are four columns on this window which represent the 
 

Each grade in a custom grade scale is associated with a grade on the Sheldon 
Scale.  The image above depicts the simplified scale of just five grades listed above; notice that the five grades 

50, MS-60, MS-63 and MS-65. 

     Once our simplified grade scale is assigned to one or 
more coin series (with the “Properties” window as 
described on the previous page) then the price list for that 
series will display just the five grades in our user-defined 
scale.  When entering coins in that type, the “Grade” box 
on the Coins page will offer the five grades from our User 
Defined grade scale. 
 
  

grade scale to a series.  The User Defined 
Graded Scales window lets you design a custom scale for this purpose.  To define custom grade scales, click on “Program settings” in 

t five grades listed above; notice that the five grades from “Nasty” to “Gem 

Once our simplified grade scale is assigned to one or 
more coin series (with the “Properties” window as 
described on the previous page) then the price list for that 

defined 
scale.  When entering coins in that type, the “Grade” box 
on the Coins page will offer the five grades from our User 



User defined fields   
 
     User fields give you the opportunity to track
information you wish for each coin in your collection.  On 
the Coins page where you enter information about each coin 
there are a number of boxes to enter information such as the 
year minted, grade and so forth.  User fields allow you to add 
your own data entry boxes.  To create user defined fields
click on “Program settings” in the program’s “File” menu, 
then click on “User Defined Grade Scales”   
 
 
     There are thirteen different types of fields that you can 
add, depending on what type of information you want to add 
to your collection database.  For example, there’s one 
for inputting a number, one for typing in text, a yes/no 
checkmark and so forth. The leftmost column lists the 
thirteen different types of fields that you can choose from.
When you select one of these field types and then click the 
“Add” button, that field is added to the middle column, which lists all the user defined fields that you’
box that says “Label”; this can be used to specify th
added a check box field with a label “Found in circulation” and a text box field labeled “Dealer name”; when we the “OK” butt
look at the Coins page, there will be two new fields on the form at the bottom of the window:
 

 
  If you have more than one collection file, each file can have its own set of user defined fields.  The fields you add are saved 
your collection file.  So dad can have one set of user defined fields in his collection and Junior may have a completely different set of 
fields.  When you open a collection file, Exact Change loads the list of fields for that collection.

User fields give you the opportunity to track whatever 
information you wish for each coin in your collection.  On 
the Coins page where you enter information about each coin 
there are a number of boxes to enter information such as the 
year minted, grade and so forth.  User fields allow you to add 

create user defined fields, 
click on “Program settings” in the program’s “File” menu, 

There are thirteen different types of fields that you can 
ormation you want to add 

to your collection database.  For example, there’s one type 
inputting a number, one for typing in text, a yes/no 

The leftmost column lists the 
thirteen different types of fields that you can choose from.  
When you select one of these field types and then click the 
“Add” button, that field is added to the middle column, which lists all the user defined fields that you’ve created.  On the ri
box that says “Label”; this can be used to specify the text that will appear above the box on the Coins page.  In the above image we’ve 
added a check box field with a label “Found in circulation” and a text box field labeled “Dealer name”; when we the “OK” butt

new fields on the form at the bottom of the window: 

one collection file, each file can have its own set of user defined fields.  The fields you add are saved 
So dad can have one set of user defined fields in his collection and Junior may have a completely different set of 

fields.  When you open a collection file, Exact Change loads the list of fields for that collection. 

ve created.  On the right side is a 
e text that will appear above the box on the Coins page.  In the above image we’ve 

added a check box field with a label “Found in circulation” and a text box field labeled “Dealer name”; when we the “OK” button and 

 

one collection file, each file can have its own set of user defined fields.  The fields you add are saved as part of 
So dad can have one set of user defined fields in his collection and Junior may have a completely different set of 



There are thirteen different types of user definable fields available… 

Text box: Used to enter text.  This is similar to the “Comments” box on the coin page. 

History drop-down: Used to enter text.  This box also provides a drop-down menu that will automatically display previous responses.  
This is similar to the “Graded by” box on the coins page.  The “Display as top 10 list” setting tells Exact Change to include only the 10 
most frequently used responses in the drop-down menu. 

Pick list: Used to select from a pre-defined list of responses.  When this type of field is added, you’ll have the opportunity to enter a list 
of valid responses.  On the coin’s page you will be required to select one of the predefined choices. 

Text box & pick list:  Used to enter text or select from a pre-defined list of responses.  When this type of field is added, you’ll have the 
opportunity to enter a list of valid choices.  On the coins page you can either type in text or pick a pre-defined option from the 
drop-down menu.  This is similar to the “Stored in” box on the coins page. 

Check box: Used to enter a yes/no style checkbox.  This is similar to the “Mint error” box on the coins page. 

Monetary value: Used to enter a value in dollars and cents, or whatever currency you’re using.  This is similar to the “Buy price” box 
on the coins page. 

Date: Used to enter a calendar date.  This is similar to the “Date purchased” box on the coins page. 

Number: Used to enter a numeric value.  The length setting determines the number of digits that may be entered on the coins page.  
This is similar to the “Have” box on the coins page. 

Phone:  Used to enter a phone number.  Exact Change will automatically format the telephone number as it’s entered. 

Attachment:  Used to attach a file or web page to a coin.  A button beside the box automatically opens the attached file or web page. 

Empty space:  Used to space other user-defined fields so that they can be grouped in a more meaningful layout. 

Certification:  Used to enter information from a certified slab.  A button beside that box will open the relevant NGC Verification site 
or the PCGS CoinFacts™ web site.  The “Graded by” box on the “Coins” page determines which page will open.  

Real number:  Used to enter a number that may contain a decimal point.  This is similar to the “Content” field on the “Prices” page.    

 
 
 

 
 
  



Searching series names 

     Under “Find” in the “Tools” menu is a menu option labeled “Search for text” which will scan through the names of each series, 
looking for whatever text you wish to find.  This can be used to find a series when all that is known is its name.  For example, you may 
have Slovenia listed under Yugoslavia (since Slovenia is a successor state to Yugoslavia).  If you’re looking for Slovenia between 
Slokavia nd Solomon Islands and you don’t see it there, you can use the “Find Text” feature to find a series with the word “Slovenia” and 
the program will automatically select the Slovenia series inside of Yugoslavia.    

 

Finding a coin by item number 
 
     As you add items to your collection, the program assigns each entry a unique item number.  This number can be used to quickly 
locate an item, by using the “Find a coin by item number” window. 
 
     To pull up this window, just click on the Help menu on the top of Exact Change and then click on “Find a coin by item number”.  
Simply type the desired item number into the space provided and click the OK button. 
 
     The program will locate the item you indicate, automatically change the series if necessary, and highlight the correct item on the 
coins or note tab.  If the item you’ve indicated doesn’t match the correct view filter (Have/Need/Sell/Sold), the coin finder will add it to 
the list on the coins page anyway.  This assures that when you enter an item number, Exact Change will take you right to that coin, 
regardless of whether it’s in a different series or it has been filtered from view. 
 
     Many of the standard Exact Change reports, and any custom reports you create, can include the item numbers.  This allows you to 
quickly retrieve information about a coin which is listed in a report. 
 
Helpful tip: To make the most effective use of this feature, you may consider writing the item number on the back of the coin holder or 
envelope.  Small paper stickers are available at most stationary or computer stores, which are ideal for placing the item number on a 
certified coin’s slab.  This also assures that you’re matching a given coin with its entry in Exact Change, rather than another similar 
coin.  
 
     Exact Change can print adhesive labels and reports which include a barcode which indicates a coin’s item number.  If you have a 
bar code scanner, you can simply scan this barcode to go directly to that coin, much the same as the “Find a coin by item number” 
function. 

 

Finding a Series by catalog number 

     Under “Find” in the “Tools” menu is a menu option labeled “Find a catalog number” which can be used to 
find the series that corresponds to a given catalog number.  For example, if a seller sends you a list of coins 
which they’re offering for sale, that list may specify Krause-Mishler (or KM) numbers to indicate what type of 
coin each offering is.  That can be difficult to work with because it means scanning through the Standard 
Catalog of World coins looking for that KM number; the coins are not necessarily in KM-number order. 

The Catalog number tool in Exact Change simplifies this by creating a list of all the catalog numbers assigned 
to any coin in an entire country and presents them in an alpha-numerically sorted list.  Just click on the catalog 
number and the series associated with that catalog number will be automatically selected on the “Series” page. 

A coin series may include more than one catalog number.  In that case, clicking one any catalog number that is 
part of that series would select that same series.  Conversely, more than one series may contain the same 
catalog number.  In that case, the catalog number will be listed twice or more, with each listing connected to a 
different series. 

 

 
 

 

 



The Bullion Values tool 
 
     The “Bullion values” menu option in the “Tools” menu provides several tools 
for working with bullion coinage and calculating melt values.
 
 When the Exact Change program starts, it downloads the current spot price 
for an ounce of silver, gold, palladium and platinum
allow you to override those values if, for example, you didn’t have access to the 
internet or you wanted to try some “what if” scenario wi
changes you make to the spot prices will be overwritten the next time the program is 
opened and it download the spot prices again, unless you uncheck the box labeled 
“Automatically update spot prices”, 
 
      On the left side is a tab labeled “Conversions”.  This tab provides a 
handy tool for converting pennyweights to grams, grams to ounces, and so forth.  It 
can be used, for example, to calculate the melt value of a coin when it
expressing in grains.  Just type a value for any unit and the equivalent amount will
be displayed for all the other units of measure.  
 
The tab labeled “Purity calculator” can calculate a coin’s precious metal content, its
purity or total weight.  Given any two of these three values, the
will find the missing value.  
 
 

Foreign Exchange rates 
 
     In the “Tools” menu is a menu option titled “Exchange rates” 
which can be used to calibrate Exact Change’s price lists to the local 
currency for any users who prefer pricing in a currency other than U.S. 
Dollars. 
 
     Exact Change downloads a table of foreign exchange rates for 126 
currencies used around the world.  If you click on any of the listed 
currency systems and then click the button labeled “Select this 
currency”, Exact Change will show all monetary values in that curr
 
 
 

Menu Shortcuts  
 
     Under “Program settings”, in the “File” menu, is a menu option labeled “Menu 
Shortcuts” which can be used to assign keyboard shortcuts for quick access to most 
of the menu options in the program.   
 
     For example, if you frequently use the “Find text” menu option, you may want 
to create a keyboard shortcut so that the F1 key brings up the “Find text” window so 
that you don’t need to navigate the menu to get to that feature.
 
     To create a keyboard shortcut, just click on the desired function in the Menu 
Shortcuts list.  A pop-up box provides the opportunity to specify the key sequence 
that will activate the corresponding menu option.
 
 
 
 
 
 

The “Bullion values” menu option in the “Tools” menu provides several tools 
bullion coinage and calculating melt values. 

When the Exact Change program starts, it downloads the current spot price 
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which can be used to calibrate Exact Change’s price lists to the local 
currency for any users who prefer pricing in a currency other than U.S. 

ange downloads a table of foreign exchange rates for 126 
currencies used around the world.  If you click on any of the listed 
currency systems and then click the button labeled “Select this 
currency”, Exact Change will show all monetary values in that currency.  

Under “Program settings”, in the “File” menu, is a menu option labeled “Menu 
Shortcuts” which can be used to assign keyboard shortcuts for quick access to most 

frequently use the “Find text” menu option, you may want 
to create a keyboard shortcut so that the F1 key brings up the “Find text” window so 
that you don’t need to navigate the menu to get to that feature. 

on the desired function in the Menu 
up box provides the opportunity to specify the key sequence 

that will activate the corresponding menu option.      



 
 
 

Utilizing coin tracking  
 
     On the Coins page is a checkbox labeled “Track”.   This box is used to indicate coins that match search criteria and it’s use
conjunction with the “Search & track” feature.  When you do a search for certain types of coins, exact change will check 
every coin that matches the search.  You can also 
 
     When you save your collection, Exact Change also saves the tracking status of each coin.  When you op
time, these coins will still be tracked.  This allows you to retain the results of your last search even when you exit the pr
 
     When there are coins in your collection that are marked as tracked, you can brows
selecting “Find next Tracked Coin” from the 
switching from one coin series to another as needed. 
 
 
Search & Track  
 
     The Search and track function is a powerful tool for locating 
all the coins that match a certain criteria.   For example, if you 
want to locate all the coins you purchased within a given date 
range, you can use the Search and Track function to mark al
coins as tracked. 
 
     In the “Tools” menu, click on “Coin tracking” and then 
“Search & track”.  The Search & track window provides the 
opportunity to designate what criteria you want to search for.  
These criteria are cumulative, so you can search, for example, for 
coins of a given grade from a certain date range and price range.
 
     The search and track window displays the number of coins 
that match your search criteria.  When you click the “
matching coins” button, all of these coins will be marked as 
tracked.  By doing another search you can track additional coins.  
This enables you to track, for example, coins from either of two different date ranges.  If you already have coins marked as tracked you 
can press the button labeled “Clear existing tracks” to remove these coins from the tracking list so that only coins from you
search will be tracked. 
 
     When there are coins in your collection that are marked as tracked, you can brows
selecting “Find next tracked coin” from the tracking menu.  Exact Change will locate the next tracked coin in your collec
from one coin series to another as needed.  
 

     A friend wants to purchase an annual set for the year 1925.  You do a search with a minimum and maximum year of 
wants lower mint state coins so you include that grade r
found by the search and discover that you have one coin of each denomination but you have
so you pick one and untrack the other.  Now you add the tracked coins to the report bin and you can print a list of the coins in the report 
bin, an annual set from 1925 in lower mint state grades.
 
     Notice that coin tracking and the search feature work together to provide a powerful searchi
mark each of the matching coins as tracked.  You can then brows
next tracked coin” from the tracking menu.  The results of your search are reflected
 
 
 
 
  

On the Coins page is a checkbox labeled “Track”.   This box is used to indicate coins that match search criteria and it’s use
conjunction with the “Search & track” feature.  When you do a search for certain types of coins, exact change will check 

also check or uncheck this box yourself if you want to manual fine

When you save your collection, Exact Change also saves the tracking status of each coin.  When you op
time, these coins will still be tracked.  This allows you to retain the results of your last search even when you exit the pr

When there are coins in your collection that are marked as tracked, you can browse through the coins by pressing Control
selecting “Find next Tracked Coin” from the “Tools” menu.  Exact Change will locate the next tracked coin in your collection, 
switching from one coin series to another as needed.  

is a powerful tool for locating 
all the coins that match a certain criteria.   For example, if you 
want to locate all the coins you purchased within a given date 
range, you can use the Search and Track function to mark all these 

click on “Coin tracking” and then 
track window provides the 

opportunity to designate what criteria you want to search for.  
These criteria are cumulative, so you can search, for example, for 
coins of a given grade from a certain date range and price range. 

w displays the number of coins 
that match your search criteria.  When you click the “Track 

” button, all of these coins will be marked as 
tracked.  By doing another search you can track additional coins.  

e, coins from either of two different date ranges.  If you already have coins marked as tracked you 
can press the button labeled “Clear existing tracks” to remove these coins from the tracking list so that only coins from you

When there are coins in your collection that are marked as tracked, you can browse through the coins by pressing Control
selecting “Find next tracked coin” from the tracking menu.  Exact Change will locate the next tracked coin in your collec

An example: 
A friend wants to purchase an annual set for the year 1925.  You do a search with a minimum and maximum year of 

wants lower mint state coins so you include that grade range in your search.  Using Control-T you flip though each of the coins that were 
you have one coin of each denomination but you have two of the dollar 

Now you add the tracked coins to the report bin and you can print a list of the coins in the report 
bin, an annual set from 1925 in lower mint state grades. 

Notice that coin tracking and the search feature work together to provide a powerful searching capability.  The search feature will 
mark each of the matching coins as tracked.  You can then browse through the tracked coins by pressing Control
next tracked coin” from the tracking menu.  The results of your search are reflected in the “Tracking” box on each coin.

On the Coins page is a checkbox labeled “Track”.   This box is used to indicate coins that match search criteria and it’s used in 
conjunction with the “Search & track” feature.  When you do a search for certain types of coins, exact change will check this box on 

check or uncheck this box yourself if you want to manual fine-tune the search results. 

When you save your collection, Exact Change also saves the tracking status of each coin.  When you open your collection next 
time, these coins will still be tracked.  This allows you to retain the results of your last search even when you exit the program. 

coins by pressing Control-T or 
.  Exact Change will locate the next tracked coin in your collection, 

e, coins from either of two different date ranges.  If you already have coins marked as tracked you 
can press the button labeled “Clear existing tracks” to remove these coins from the tracking list so that only coins from your current 

through the coins by pressing Control-T or 
selecting “Find next tracked coin” from the tracking menu.  Exact Change will locate the next tracked coin in your collection, switching 

A friend wants to purchase an annual set for the year 1925.  You do a search with a minimum and maximum year of 1925.  He 
T you flip though each of the coins that were 

of the dollar coins.  He only needs one, 
Now you add the tracked coins to the report bin and you can print a list of the coins in the report 

ng capability.  The search feature will 
through the tracked coins by pressing Control-T or selecting “Find 

in the “Tracking” box on each coin. 



Image Repository  
 
     When pictures on the “Images” page are attached to a coin entry, the Exact Change collection doesn’t add the picture to your 
collection database; instead it just adds the name and location of the file to your collection database.  These images can come from 
anywhere on any drive in your computer, but it’s generally a good idea to organize the images of your coins in one directory 
can easily make a backup. 
 
     There may be situations where you’d like to move all of the 
images to a new location, The most common example is when a 
collection file is shared between a Mac and a PC; those systems 
are different so the location of a picture (its “Path”) is completely 
different on the two systems.  This could mean that a collection 
created on one system wouldn’t be able to locate the coin images 
when loaded on another system. 
 
     The solution for that issue is the Image Repository.  Quite 
simply, the image repository is just a directory that you designate 
as the place where you’re going to store your coin images.  Even 
so, there is nothing that requires you to save all of your
images in that directory, but when you do, Exact Change can 
perform a handy little trick; rather than save the full path of the 
image file, it just stores the location relative to the repository.  For example:
 
On a Windows PC, a picture path may look something like this:

C:\Documents\Exact Change\Repository
 
While on a Mac, a typical path would look more like this:

/Library/Application Support/Exact Change/Repository/MyCoin.jpg
 
When you attach a picture to a coin entry on the “Images” pa
designated as the Image Repository and, if so, will store its location relative to that Directory; it will look something lik

<Repository>MyCoin.jpg 
 
When Exact Change needs to display the image, it will replace the word <Repository> with the actual directory you specified as the 
Image Repository to get the full path of that picture file.  This means, for example, that you could move all of your picture
drive to another and the program would be able to locate those images when needed, as long as you changed the Image Repository to 
point to the new location of those picture files. 
 
 
 
     
  

are attached to a coin entry, the Exact Change collection doesn’t add the picture to your 
instead it just adds the name and location of the file to your collection database.  These images can come from 

anywhere on any drive in your computer, but it’s generally a good idea to organize the images of your coins in one directory 

There may be situations where you’d like to move all of the 
images to a new location, The most common example is when a 
collection file is shared between a Mac and a PC; those systems 

ts “Path”) is completely 
different on the two systems.  This could mean that a collection 
created on one system wouldn’t be able to locate the coin images 

The solution for that issue is the Image Repository.  Quite 
simply, the image repository is just a directory that you designate 

’re going to store your coin images.  Even 
so, there is nothing that requires you to save all of your coin 
images in that directory, but when you do, Exact Change can 
perform a handy little trick; rather than save the full path of the 

to the repository.  For example:  

ok something like this: 
Repository\MyCoin.jpg 

While on a Mac, a typical path would look more like this: 
Application Support/Exact Change/Repository/MyCoin.jpg 

When you attach a picture to a coin entry on the “Images” page, Exact Change will notice if that picture is in the directory that’s 
designated as the Image Repository and, if so, will store its location relative to that Directory; it will look something lik

display the image, it will replace the word <Repository> with the actual directory you specified as the 
Image Repository to get the full path of that picture file.  This means, for example, that you could move all of your picture

other and the program would be able to locate those images when needed, as long as you changed the Image Repository to 

are attached to a coin entry, the Exact Change collection doesn’t add the picture to your 
instead it just adds the name and location of the file to your collection database.  These images can come from 

anywhere on any drive in your computer, but it’s generally a good idea to organize the images of your coins in one directory so that you 

ge, Exact Change will notice if that picture is in the directory that’s 
designated as the Image Repository and, if so, will store its location relative to that Directory; it will look something like this: 

display the image, it will replace the word <Repository> with the actual directory you specified as the 
Image Repository to get the full path of that picture file.  This means, for example, that you could move all of your picture files from one 

other and the program would be able to locate those images when needed, as long as you changed the Image Repository to 



Converting Hebrew dates  

     Israeli coins are minted with Hebrew dates.  This can be an impediment for 
some world coin collectors because of the difficulty in determining when a coin was 
minted.  Exact Change includes a Hebrew date converter, which will easily convert 
between western and Hebrew dates.  You’ll find it under “Date converters” in the 
“Tools” menu. 

     To covert an Israeli coin’s date, simply click the buttons that represent the 
characters in the coin’s date.  The date converter will then display the standard date 
in the box labeled “Gregorian year”.  A Hebrew date will include up to 2 
from the first row, possibly one from the second row, and up to three 
the third row.  Because of the way Hebrew numbers work, it doesn’t 
order you click on the buttons.  Conversely, you can type in the standard date and the 
date converter will automatically click the correct button and display the date in its 
Hebrew form.  

     When the date converter displays a date in it
characters will be displayed in gray.  These are characters which may or may not be included in the date.  The double quote i
that the characters represent a number and not a Hebrew word.  On some coins this appears as a s
appears in gray because it represents which millennium the coin is from.   Many coins don’t include this character; it’s assu
they’re from the current millennium.  

 
     Each letter in the Hebrew alphabet has a numeric value.    The same character can represent a letter or a number.  Because of this, 
it can be difficult to determine what writing on the coin is actually the coin’s date.  Any writing on the coin could be a nu
word.  For example, the word “Israel” is written exactly like the number 10,501,030.  You could mistakenly enter the coin’s 
denomination into the date converter, and it will diligently convert the word “Argot” to a Gregorian date (Albeit, a nonsensi
you select the correct Hebrew characters to represent the date and the converter gives you a ridiculous Gregorian date, reexamine the 
coin to determine if you’ve correctly located the date.  Remember that a single or double quote indicates a numeric value.
 
     Several characters are difficult to discern.  Particularly the letters representing 4, 6 , 7 and 200, and the letters 
representing 9, 40 and 60.  This is particularly true when different fonts are used on various coin series.  You’ll find that
dates include one character from the first row, one from the second, and one or more from the third 
the Jewish year ends in 15 or 16.  For religious reasons, 15 and 16 are shown as a combination of (9+6) and (9+7) rather than
(10+6). 
 
     Note that the Jewish New Year begins with Rashashana, an autumn festival, rather than on January 1
late in the year may have been minted a year before the date indicated by the converter.  This is especially true of Cha
because Chanukah falls between Rashashana and January 1
date converter is the one Exact Change will use to track the coin and associate it with an entry in the price
 

 
  

Israeli coins are minted with Hebrew dates.  This can be an impediment for 
some world coin collectors because of the difficulty in determining when a coin was 
minted.  Exact Change includes a Hebrew date converter, which will easily convert 

You’ll find it under “Date converters” in the 

To covert an Israeli coin’s date, simply click the buttons that represent the 
characters in the coin’s date.  The date converter will then display the standard date 

A Hebrew date will include up to 2 characters 
from the first row, possibly one from the second row, and up to three characters from 
the third row.  Because of the way Hebrew numbers work, it doesn’t matter what 

Conversely, you can type in the standard date and the 
date converter will automatically click the correct button and display the date in its 

date in its Hebrew form, two of the 
characters will be displayed in gray.  These are characters which may or may not be included in the date.  The double quote i
that the characters represent a number and not a Hebrew word.  On some coins this appears as a single quote mark.  The final character 
appears in gray because it represents which millennium the coin is from.   Many coins don’t include this character; it’s assu

a numeric value.    The same character can represent a letter or a number.  Because of this, 
it can be difficult to determine what writing on the coin is actually the coin’s date.  Any writing on the coin could be a nu

d “Israel” is written exactly like the number 10,501,030.  You could mistakenly enter the coin’s 
denomination into the date converter, and it will diligently convert the word “Argot” to a Gregorian date (Albeit, a nonsensi

ct Hebrew characters to represent the date and the converter gives you a ridiculous Gregorian date, reexamine the 
coin to determine if you’ve correctly located the date.  Remember that a single or double quote indicates a numeric value.

cters are difficult to discern.  Particularly the letters representing 4, 6 , 7 and 200, and the letters 
representing 9, 40 and 60.  This is particularly true when different fonts are used on various coin series.  You’ll find that

aracter from the first row, one from the second, and one or more from the third row.  The only exception is when 
the Jewish year ends in 15 or 16.  For religious reasons, 15 and 16 are shown as a combination of (9+6) and (9+7) rather than

Note that the Jewish New Year begins with Rashashana, an autumn festival, rather than on January 1
late in the year may have been minted a year before the date indicated by the converter.  This is especially true of Cha
because Chanukah falls between Rashashana and January 1st.  This is a rather academic point though, because the date indicated by the 
date converter is the one Exact Change will use to track the coin and associate it with an entry in the price

characters will be displayed in gray.  These are characters which may or may not be included in the date.  The double quote indicates 
ingle quote mark.  The final character 

appears in gray because it represents which millennium the coin is from.   Many coins don’t include this character; it’s assumed that 

a numeric value.    The same character can represent a letter or a number.  Because of this, 
it can be difficult to determine what writing on the coin is actually the coin’s date.  Any writing on the coin could be a number, or a 

d “Israel” is written exactly like the number 10,501,030.  You could mistakenly enter the coin’s 
denomination into the date converter, and it will diligently convert the word “Argot” to a Gregorian date (Albeit, a nonsensical date). If 

ct Hebrew characters to represent the date and the converter gives you a ridiculous Gregorian date, reexamine the 
coin to determine if you’ve correctly located the date.  Remember that a single or double quote indicates a numeric value. 

cters are difficult to discern.  Particularly the letters representing 4, 6 , 7 and 200, and the letters 
representing 9, 40 and 60.  This is particularly true when different fonts are used on various coin series.  You’ll find that most 

row.  The only exception is when 
the Jewish year ends in 15 or 16.  For religious reasons, 15 and 16 are shown as a combination of (9+6) and (9+7) rather than (10+5) and 

Note that the Jewish New Year begins with Rashashana, an autumn festival, rather than on January 1st.  This means a coin minted 
late in the year may have been minted a year before the date indicated by the converter.  This is especially true of Chanukah coins, 

.  This is a rather academic point though, because the date indicated by the 
date converter is the one Exact Change will use to track the coin and associate it with an entry in the price list. 



Converting Arab dates  

     Many Middle Eastern coins are minted with Arab dates.  This can be an 
impediment for some world coin collectors because of the difficulty in determining 
when a coin was minted.  Exact Change includes an Arabic date converter, which will 
easily convert between a Christian Era (A.D.) date and an Arabic date.

 
     To covert an Arab coin’s date, simply click the buttons that represent the 
characters in the coin’s date.  The date converter will then display the standard date in 
the box labeled “A.D.”.  Each Arab character you click on will be added to the right 
side of the date, pushing the leftmost character out.  To clear the displayed date and 
start with a blank box, just click on the white box that displays the date in Arabic.  
Conversely, you can type in the standard date and the date converter will display t
date in its Arab form.   
 
     Arab dates use a different set of characters to represent the numbers zero through nine.  The date those characters indicate 
according to any one of four different calendars.  The Christian Era (A.D.) calendar dates
given in A.D. format, it is unusually represented in Arab characters on the coin.  The Muslim Era (A.H.) calendar dates to 62
when Mohamed fled from Mecca.  It is a lunar based calendar, rather than a so
of the moon around the earth rather than one orbit of the earth around the sun.  Because of this, an A.H. year is slightly sh
standard year.  The Arab New Year, therefore, shifts slight
winter will twenty year latter end up in the summer.  The Monarchic Solar (M.S.) calendar was used for a short time in the mi
in Iran.  It is based on a solar year of 365 days and begins in 559 B.C.  The Solar Year (S.H.) calendar is a solar based calendar of 365 
days which dates to 621 A.D.  This calendar is used primarily in Iran and Afghanistan.  It works like A.H. dating, but it has
starting year. 

 
     Often an Arab coin will display both the A.H. and A.D. dates, both in Arab characters.  When you enter one of these dates, Exact 
Change can determine automatically whether you’ve entered an A.H. date or an A.D. date.  It does this by assuming that any da
to 1500 is an A.H. date and anything after that is an A.D. date.  For example, if you click on 
assumes that this is an A.D. date and will display it as such.
 
 

Converting Japanese dates   

     Japanese coins don’t actually include a date.  Rather, they indicate the Emperor 
and the year of his reign.  So to convert to a western date, it’s important to know 
dates of each emperor’s rule.  Fortunately, Exact Change takes care of this for yo

 
This symbol translates to “Year” can help you identify the year on 
the coin because it always appears on the left or right of the date.  It 
may appear on either side because early coins were written right to 
left and since 1948 coin dates have been 
worry, exact change takes care of that for you as well).
 

     Each emperor is represented by two characters which are displayed as you click 
on the “Back” and “Next” buttons to scroll through the list of emperors.  These 
characters will be on the opposite end of the date from the year symbol.
 
     Between the year symbol and the Emperor's symbols will be from one to three characters.  These characters in the middle may b
Japanese characters or western characters depending on 
side of the date converter until you see these 1-3 characters and the western date will be listed to the right.

 

 

  

Many Middle Eastern coins are minted with Arab dates.  This can be an 
impediment for some world coin collectors because of the difficulty in determining 

cludes an Arabic date converter, which will 
easily convert between a Christian Era (A.D.) date and an Arabic date. 

To covert an Arab coin’s date, simply click the buttons that represent the 
characters in the coin’s date.  The date converter will then display the standard date in 
the box labeled “A.D.”.  Each Arab character you click on will be added to the right 
ide of the date, pushing the leftmost character out.  To clear the displayed date and 

start with a blank box, just click on the white box that displays the date in Arabic.  
Conversely, you can type in the standard date and the date converter will display the 

Arab dates use a different set of characters to represent the numbers zero through nine.  The date those characters indicate 
according to any one of four different calendars.  The Christian Era (A.D.) calendar dates from the birth of Christ.  Though the date is 
given in A.D. format, it is unusually represented in Arab characters on the coin.  The Muslim Era (A.H.) calendar dates to 62
when Mohamed fled from Mecca.  It is a lunar based calendar, rather than a solar calendar.  That means a year consists of twelve orbits 
of the moon around the earth rather than one orbit of the earth around the sun.  Because of this, an A.H. year is slightly sh

, therefore, shifts slightly each year in relation to January 1st.  An Arab holiday celebrated in the 
winter will twenty year latter end up in the summer.  The Monarchic Solar (M.S.) calendar was used for a short time in the mi

ays and begins in 559 B.C.  The Solar Year (S.H.) calendar is a solar based calendar of 365 
days which dates to 621 A.D.  This calendar is used primarily in Iran and Afghanistan.  It works like A.H. dating, but it has

an Arab coin will display both the A.H. and A.D. dates, both in Arab characters.  When you enter one of these dates, Exact 
Change can determine automatically whether you’ve entered an A.H. date or an A.D. date.  It does this by assuming that any da
to 1500 is an A.H. date and anything after that is an A.D. date.  For example, if you click on the characters for 2003, Exact Change 

is an A.D. date and will display it as such. 

Japanese coins don’t actually include a date.  Rather, they indicate the Emperor 
o convert to a western date, it’s important to know the 

dates of each emperor’s rule.  Fortunately, Exact Change takes care of this for you. 

This symbol translates to “Year” can help you identify the year on 
the coin because it always appears on the left or right of the date.  It 
may appear on either side because early coins were written right to 
left and since 1948 coin dates have been written left to right (don’t 
worry, exact change takes care of that for you as well). 

Each emperor is represented by two characters which are displayed as you click 
on the “Back” and “Next” buttons to scroll through the list of emperors.  These 

cters will be on the opposite end of the date from the year symbol. 

Between the year symbol and the Emperor's symbols will be from one to three characters.  These characters in the middle may b
Japanese characters or western characters depending on the type of coin you’re look at.  Just scroll through the scroll box on the right 

3 characters and the western date will be listed to the right.

Arab dates use a different set of characters to represent the numbers zero through nine.  The date those characters indicate may be 
from the birth of Christ.  Though the date is 

given in A.D. format, it is unusually represented in Arab characters on the coin.  The Muslim Era (A.H.) calendar dates to 622 A.D. 
lar calendar.  That means a year consists of twelve orbits 

of the moon around the earth rather than one orbit of the earth around the sun.  Because of this, an A.H. year is slightly shorter than a 
.  An Arab holiday celebrated in the 

winter will twenty year latter end up in the summer.  The Monarchic Solar (M.S.) calendar was used for a short time in the mid-1970’s 
ays and begins in 559 B.C.  The Solar Year (S.H.) calendar is a solar based calendar of 365 

days which dates to 621 A.D.  This calendar is used primarily in Iran and Afghanistan.  It works like A.H. dating, but it has a different 

an Arab coin will display both the A.H. and A.D. dates, both in Arab characters.  When you enter one of these dates, Exact 
Change can determine automatically whether you’ve entered an A.H. date or an A.D. date.  It does this by assuming that any date prior 

the characters for 2003, Exact Change 

Between the year symbol and the Emperor's symbols will be from one to three characters.  These characters in the middle may be 
the type of coin you’re look at.  Just scroll through the scroll box on the right 

3 characters and the western date will be listed to the right. 



Converting Nepal dates  

     Coins of Nepal are minted dated according the V.S.  (Bikram Samvat) era and use Nepalese characters.  
Just click on the buttons that match the four characters you see on your coin and Exact Change will decode 
the date for you. 

 Converting Thai dates  

     Coins of Thailand are minted with Thai dates.  They use a different set of characters to represent the 
numbers zero through nine, and are dated according to the Buddhist Era (B.E.) which dates from 543 B.C.  

Converting Bengali dates  

     Bangladeshi coins are minted with Bengali dates.  The Bengali date converter is the simplest of Exact 
Change’s date converters.  This is because Bengali coins are dated according to the standard Christian Era 
(A.D.) calendar; they simply use a different set of characters to represent the numbers zero though nine. 

Converting Roman Numbers  

     Many coins contain a roman numeral as part of their design.  This may indicate the date, the 
denomination, or the year of a ruler’s reign.  Exact Change’s roman number converter makes it easy to 
convert between Roman and Arabic numbers. 

     To convert an Arabic number to Roman, just type the number into the space labeled “Arabic”.  As you type, the Roman equivalent 
will appear in the space labeled “Roman number”.  To convert the opposite direction, just type the roman number into the space labeled 
“Roman number” and the equivalent value will appear in the space labeled “Arabic”.  If you enter a roman number that is not properly 
formatted, the converter will display a message indicating the problem.  If possible, Exact Change will convert the number anyway and 
display the properly formatted Roman number as well as the Arabic equivalent. 

Converting Taiwanese dates  

     Coins of Taiwan are minted with Chinese dates.  The Taiwan date converter is similar to the Japanese 
converters except that it shows four characters that indicate “Republic of China” where the Japanese coins 
indicate the emperor.  Like their Japanese counterpart, Taiwanese coins begin with a symbol that translates 
to “Year”.  They are dated from the establishment of the republic of China in 1911.   

Converting Burmese dates  

     Coins of Myanmar (Formerly Burma) are minted with Burmese dates.  They use a different set of 
characters to represent the numbers zero through nine, and are dated according to the Chula-Sakarat (C.S.) era 
which dates from 638 A.D. 

 
 
 
 

 
 
  



 

Coin collecting software should be for the study of coins, not the study of 
software manuals.  It should be a tool that enhances your enjoyment of your 

collection rather than forcing you through the drudgery of endless data entry.  It 
should help your collection “Come alive” as it immerses you into a world of 

imagery and information.  It should instill a feeling that this coin in your hand is 
a piece of history, not just a chunk of metal to be cataloged. 

Now it will…  Exact Change 
 
 

 
“Exact Change is always appreciated” 

                  -Metro bus driver 
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Copyright Notice 

No part of this documentation or the enclosed software may be reproduced by any means without the express written 
permission of the author. This computer program is protected by copyright law and international treaties.  
Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal 
penalties and will be prosecuted to the maximum extent possible under law. 
 

Disclaimer 
This software product is provided as is, without warranty of any kind, either expressed or implied, including but not 
limited to the implied warranties of merchantability and fitness for a particular purpose. The entire risk as to the use of 
this product is assumed by the user. Neither the author, nor any distributor assumes any liability for direct or indirect 
damages including any lost profits, lost savings, or other incidental or consequential damages arising from any defects, 
or the use or inability to use this product, even if said party has been advised of the possibility of such damages. Under 
no circumstances shall the liability of the software exceed the initial license fee. 
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